Project EDDIE: Wind and Ocean Ecosystems

By the end of this module you will be able to answer the question: how does wind impact ocean ecosystems?

Learning Objectives
· Students will be able to generate a wind rose plot in Excel.
· Students will be able to explain how wind direction and strength influence physical and biological ocean processes.
· Students will be able to find a location on a map using latitude and longitude.
· Students will be able to explain the relationships between wind bearing and direction.
· Students will be able to convert between wind direction in degrees and wind direction using the cardinal and ordinal directions.
· Students will be able to interpret a choropleth map.
Why This Matters
The study of ocean organisms and systems is inherently interdisciplinary. This module reinforces for students the interdisciplinary nature of oceanography. Furthermore, by using existing oceanographic observing systems, this module allows students to experience authentic oceanographic research and garner a better understanding of how science is conducted in marine settings.

Outline
1. Lecture on coordinate systems and buoys 
2. Activity A: How do we find wind data?
3. Lecture on wind direction and ocean currents
4. Activity B: How does wind influence ocean currents?
5. Lecture on upwelling
6. Activity C: How does wind impact upwelling?
7. Lecture on satellite data
8. Activity D: How does wind impact ocean ecosystems?

Part A: How do we find wind data?

As scientists, whatever your background, we always need sources of real-world data. For this exercise, we will explore how wind direction influences ocean ecosystems. In order to do this, we need to access data to explore patterns. How do we find ocean current data? This might be a challenge! Fortunately for us, the United States funds the National Oceanic and Atmospheric Administration (NOAA), which pilots multiple types of scientific exploration specifically related to ocean and earth systems. The National Data Buoy Center (NDBC) is a part of NOAA’s National Weather Service (NWS). The NBDC created a system of buoys throughout the world, and maintains this system, collecting data from buoys and coastal stations.  We will access the NDBC to gather real time data from buoys in the Northern Atlantic to get information of wind direction and speed.

In order to start processing this data, we need to know information about latitude and longitude. Are those terms familiar to you? They might be, but most likely you have never used latitude and longitude to plot locations on a map. Latitude and longitude are a series of imaginary lines that create a grid over the surface of the Earth. 
[image: C:\Users\magnu\AppData\Local\Microsoft\Windows\INetCache\IE\WN2QRPCX\1024px-Latitude_and_Longitude_of_the_Earth.svg[1].png]
Lines of latitude run north and south moving away from the Equator. At the equator, we say we are at 0° latitude. As we move away from the Equator, we go up in degrees of latitude until we reach the poles. At the poles, we say we are at 90° N/S latitude. When we navigate using longitude, we move east and west away from the Prime Meridian (In fact we call lines of longitude meridians). The Prime Meridian is 0° longitude. As we move east and west away from the Prime Meridian, we move around a circle (the Earth) and navigate up to 180° E/W latitude. 
We can use latitude and longitude to give us absolute locations of our buoys. 
1. First navigate to https://www.ndbc.noaa.gov/.
2. Notice in the upper left there is a search box. [image: ]
3. Search for the following list of station ID’s. 
	Name
	Latitude 
	Longitude 

	Station 44137
	
	

	Station 41001
	
	

	Station 41002
	
	

	Station 41048
	
	

	Station 41010
	
	

	Station 41047
	
	

	Station SPGF1
	
	

	Station 44402
	
	

	Station 44139
	
	

	Station 44037
	
	



4. As an example to help guide you, let’s look at Station 41047. When you search for the station ID, notice at the top there are numbers listed. This is the latitude and longitude listed in both decimal degrees and degrees minutes seconds (the first set of numbers and the second set of numbers, respectively). You can use either set to plot latitude and longitude but for this exercise, we want you to use the decimal degrees.[image: ]
5. Look at the numbers, it lists 27.514 N (North) and 71.494 W (West). Thinking about the explanation above, which is the latitude? Which is the longitude? ________________________________________________________________________________________________________________________________________________
6. Repeat this step for all of your station ID’s. Fill in the table above. 
7. Now you will plot these stations on a map.  Use the map on the next page to plot the locations of each of the stations.
[image: ]
8. In Part D, you will check your stations are in the correct position by using a GIS layer in ArcGIS Online. 

Part B: How do winds influence ocean currents?

In this section we will explore atmospheric data collected from buoys to infer how wind direction and speed influences ocean circulation, specifically currents.  Currents are continuous and consistent flows of water along the surface of the ocean.  For this next activity, we will download data from the NDBC that gives you wind direction in degrees. We want you to practice converting from wind direction in degrees to wind direction in bearing (using the cardinal and ordinal directions). This might not be something you have ever utilized, but it is a basic mapping skill. To do this, we need to use a compass rose. A compass rose gives you the cardinal directions you are familiar with (north, east, south, and west), as well as the ordinal directions (northeast, southeast, southwest, and northwest) in degrees. We can once again imagine our directions as a circle ranging from 0° to 360°. Thus, each direction you move away from north (which is both 0° and 360°), gives you a degree around the circle. That means that true east is 90°, true south is 180°, and true west is 270°. North would be a range of numbers from 337.6° to 22.5°, northeast is 22.6° to 67.5°, east is 67.6° to 112.5°, southeast is 112.6° to 157.5°, south is 157.6° to 202.5°, southwest is 202.6° to 247.5°, west is 247.6° to 292.5°, and northwest is 292.6° to 337.5°.

[image: ]

Wind direction can be described qualitatively.  For example, wind blowing from the north can be described as northward or southerly.  The “ly” denoted that wind is blowing from that direction.  Similarly, wind that is blowing towards the east can be described as eastward or easterly.  It is important to pay attention when wind direction is being described to ensure you know which way the wind is blowing.  Wind direction is often shown using a wind rose.  A wind rose is a figure that shows quantitative data pertaining to wind speed and direction.  Look at the wind rose below:

[image: ]

A wind rose looks like a compass.  The lines radiating out from the center at regular intervals are reference lines, which denote the number of times wind was measured blew that speed.  The lines extending from the center at irregular intervals represent data.  The different colored lines denote different wind speeds.  For example, the wind rose above shows that for this location the wind blew from the Northeast at 2 m/s 25 times.  In contrast the wind blew from the south at 3 m/s almost 20 times during the data collection period.  

1. We will practice converting our wind directions in degrees to our cardinal and ordinal directions. Using the table below and the ranges/figure above, convert the degrees to cardinal/ordinal directions.
	Degrees
	Direction

	145
	

	230
	

	93
	

	3
	

	201
	

	278
	

	112
	

	250
	

	242
	

	357
	

	315
	

	33
	

	153
	

	296
	

	181
	


2. Now we will download buoy data for Station 41001. Navigate to https://www.ndbc.noaa.gov/ again and search for station ID 41001. Scroll all the way to the bottom of the page and click on Historical Data and Climatic Summaries.[image: ]

3. Under Historical Data on the next page, click on data descriptions. This is metadata. Metadata is basically ‘data about data.’ In other words, where did NOAA get this data? How did they process it? What do the data categories mean? 
[image: ]

4. [bookmark: _heading=h.gjdgxs]Under Standard meteorological data, notice it lists several data categories with abbreviations. Notice MM, DD, WDIR, and WSPD. What do these abbreviations stand for? ________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________

5. Your data will come from this database.  You will be using data from the year 2010. Your instructor will provide it to you in an Excel file.  If you access the data from the link above, you may notice that the wind direction is given in degrees.  However, in the data provided for you the wind direction has been converted into the cardinal and ordinal directions of N, NE, E, SE, S, SW, W, and NW.  You will now make a wind rose plot in Excel from this data.  Follow the instructions below to make the wind rose plot.
a. Excel is organized into columns that are represented by letters and rows that a represented by numbers.  Labels are at the top of each column.  Each row represents one time period that data was collected.  The first thing we need to do is to make sure the labels stay where they are as we sort and process the data.  Click on the ‘3’ on the left of the third row.  The entire row should light up.  
[image: ]
b. At the top click on the “view” tab.  Click “Freeze Panes”
c. Now we will sort the data to put like data points together.  This will make the data points easier to count later on.  Click on the upper left corner of the spreadsheet.  This is the gray square above the “1” and to the left of the “A”.
d. At the top click on the “Data” tab.  Click “sort”.
e. A new dialogue box should appear.  Make sure the box “My List has Headers” is checked in the upper right corner.  In the dropdown menu under “column” select “WDIRC”.  This will sort the data by the cardinal wind direction.  
f. Now for each wind direction we want to group all of the like wind speeds together.  Select all of the rows with the wind direction E.  At the top under the “Data” tab click “Sort”.
g. In the new dialogue box make sure the box “My List has Headers” in NOT checked.  In the dropdown menu for column, select “Column H”.  This will order the data within the direction E by the speed.  Click “OK”. 
h. Now repeat what you did for E for all of the other wind directions: NE, N, NW, W, SW, S, and SE.
i. Create a table in your Excel sheet near the top that looks like this:
 
	Direction 
	< 2 
	 2 to <4
	4 to <6
	6 to <8
	8 to <10
	10 to <12 
	12 or greater

	N 
	 
	 
	 
	 
	 
	 
	 

	NE 
	 
	 
	 
	 
	 
	 
	 

	E 
	 
	 
	 
	 
	 
	 
	 

	SE 
	 
	 
	 
	 
	 
	 
	 

	S 
	 
	 
	 
	 
	 
	 
	 

	SW 
	 
	 
	 
	 
	 
	 
	 

	W 
	 
	 
	 
	 
	 
	 
	 

	NW 
	 
	 
	 
	 
	 
	 
	 



j. In this table we will put the number of times the wind was blowing from a certain direction at a certain speed.  For example, the most upper left corner will contain the number of times the wind was blew from the N direction less than 2 m/s.  Filling in this data will be a little bit easier if we organize our spread sheet a little bit first.
k. Under the top tab “View” click “Unfreeze Panes”.  Click a number that labels a row underneath where your table is.  Under the “View” tab click “Split”.  This will create two mini spreadsheets of your main sheet.  These mini spreadsheets are called panes.  You will be able to keep the table in view in the top spreadsheet while you count the data points in the bottom pane.  
l. Instead of actually counting the number of times the wind was blowing from a particular direction within a specific range of speeds we can take advantage of the built in Excel “count()” function.  In the cell representing the number of times the wind was blowing in the N direction less than 2 m/s type “=count(“.  Now in the bottom pane highlight the wind speed data that is less than 2 in the E section.  Be sure to only highlight the data in column H.  When you have highlighted all of the data you need type “)” then hit tab on your key board.  That cell now has the correct information,
m. Repeat step “I” for all of you wind direction/wind speed combinations.
n. You will now use the radar plot function in Excel to make your wind rose plot.  Under the top tab “Insert” find the wind rose plot.

[image: ]
o. A new blank rectangle will appear.  Right click on the rectangle.  If you are using a mac you can hold down “control” when clicking the mouse to do the same thing.  A dialogue box will appear.  Click on “Select Data”.  
p. A new dialogue box will appear.  Underneath the blank box called “Legend entries (Series)” you will see a “+”.  Click the “+”.  A box called “Name” will appear on the upper right.  Click the blank box so that a blinking cursor appears there.  Then in your table in Excel click “<2”.  Below that box there will be a box labeled “Y values”.  Highlight the data below “<2” in your table.  
q. Repeat step “p” to add all of the windspeed data to the dialogue box.  
r. With the dialogue box still open click on the box labeled “Horizontal (category) Axis Labels”.  Highlight the wind directions in your table in Excel.  Click “OK”.  Your wind rose plot is done!

6. Look at your wind rose plot.  Describe the most common directions that the wind blows and the most common wind speeds:
____________________________________________________________________________________________________________________________________________________________

7. Now look at this live graphic of the Gulf Stream: Earth Null Data
This is a live 3-hour loop of the Gulf Stream.  The data from the buoy that collected the data you used is denoted by a green circle.  Does the direction of your wind data match the direction of the Gulf Stream?  If not, how do the directions compare?
____________________________________________________________________________________________________________________________________________________________

8. You have stumbled across an important oceanographic concept called Ekman transport.  Due to the spin of the earth, in the Northern Hemisphere, water is deflected (flows) to the right of the wind blowing above it.  In the southern hemisphere water is deflected to the left of the wind blowing above it.  How is Ekman transport represented by your wind data and the Gulf Stream?  Be sure to consider that the location continent of North America may also influence the Gulf Stream.
____________________________________________________________________________________________________________________________________________________________

It is important to note that ocean circulation is very complex and driven by a multitude of forces.  Ekman transport is the most important factor.  However, it does not drive all ocean currents and circulation.  

Part C: How does wind impact upwelling?

In this section we will explore upwelling.  Upwelling a process that occurs at various locations in the ocean including eastern boundary currents and the equatorial Pacific and Atlantic.  Upwelling occurs when deep cold nutrient rich water is brought to the surface of the ocean when surface water is displaced somewhere else.  The nutrients in upwelled water serve as food for microscopic organisms called phytoplankton, causing them to use chlorophyll of photosynthesize and grow, a process called primary production.  Complete the activity below to explore how wind is involved in this process.  

For this activity you will explore data from Monterey Bay, California.  Click on this Earth Null Map to see the location of Monterey Bay and the current wind conditions.  You will use buoy data from the same database and format as you used in activity B.  However, this data was collected from a buoy located in the middle of Monterey Bay and consists of the entire year from 2010.  In addition to the data provided in the previous activity, this data also contains the water temperature (denoted as WTMP) in Celsius.  The excel file with the data will be provided to you.  You will first identify an upwelling event.  Then you will compare a wind rose plot from the upwelling even to a time when upwelling was not occurring.  

1. The first thing you will need to do is to check the data for errors.  Sometimes an instrument on the buoy will stop working momentarily or for up to weeks at a time.  When an instrument malfunctions the numbers “999” will occur where the data will be.  This is not a realistic water temperature since water boils at 100 degrees Celsius, liquid water does not exist at this temperature.  Go through the column with the water temperature data (WTMP) and delete any entries that show “999” or “999.0”.  
2. Now you will create a line plot of the water temperature to identify when an upwelling event occurs.  Highlight the date from the columns that show the date & time and the water temperature as shown below.
[image: ]
3. Now create the line plot.  At the top select the tab insert.  The select the line plot option as shown below. 
[image: ]
This will create a line plot where time is on the x-axis and water temperature is on the y-axis.  Most upwelling events occur during a time of year when the water temperature decreases for a prolonged period of time.  Looking at the line plot, in what months is upwelling most likely to occur? __________________________________________________________________________________________________________________________________________________________________________________________________________________________________________.

You should pick a single upwelling event from one of these months.  To find an upwelling event look for a sharp decreased in the water temperature.  This decrease in temperature will probably occur over a period of a few days and will last a few days to a few weeks until the water temperature warms again.  You can hover your cursor over the line to see what date these upwelling events correspond to.  Find the ending date of an upwelling event and write that date here: _______________________________________________________________________.

4. You will use the 2 weeks prior to this date to create a wind rose plot, but you need to make sure there is good data available first.  Go to your data file and find the column marked “WDIR Cardinal.”  Scroll down to the 2 weeks of data you plan to use.  If you see “N/A” that means data is not available for that date and you will need to choose a different upwelling event.  Copy and paste the data for the 2-week period you chose to represent upwelling into a different area of the sheet or into another sheet.  

5. Now you will need to find a 2-week period when no upwelling occurred to compare your upwelling data to.  Go back to your line plot and pick a 2-week period from the months when upwelling was NOT occurring and that a singular upwelling even did NOT occur.  Write the dates of that period here: _______________________________________________________________________.

6. Go back to the wind direction data for that 2-week period to ensure the data is good (i.e. there is no “N/A” in the wind direction data.  If thee data is good copy and paste the data for that 2-week period into another part of the sheet or a new sheet to work with.

7. Now create 2 wind rose plots.  One wind rose will be made from the 2-weeks of data when upwelling occurred and the other wind rose will be made from the data of when upwelling was not occurring.  Follow the directions in Part B for making a wind rose in Excel.  You may find it easier to copy and paste just the data you are working with into another sheet of your Excel spreadsheet.  You can make another sheet by clicking the “+” at the bottom of the sheet.  Be sure to add a legend and to account to wind speed in addition to wind direction when analyzing the data.

8. Compare your wind rose plots. What is the dominant wind direction in each plot?  How does the wind direction of upwelling and non-upwelling times compare?
__________________________________________________________________________________________________________________________________________________________________________________________________________________________________________.

9. According to Ekman transport during an upwelling event what direction should the surface ocean water flow during an upwelling event?
   __________________________________________________________________________________________________________________________________________________________________________________________________________________________________________.

10. Given what you now know about upwelling and Ekman transport.  How does wind direction drive upwelling in this location?
__________________________________________________________________________________________________________________________________________________________________________________________________________________________________________.


Part D:  How does wind impact ocean ecosystems?
In this part of the assignment you will continue the case study of Monterey Bay by visualizing an upwelling event with satellite data.  You will then use this visualization to describe how the upwelling event impacts the ecosystem in that area.  Remember that upwelling events bring nutrient-rich cold water to the surface which phytoplankton use to grow and photosynthesize.  

1. Navigate to ArcGIS Online and sign in with your account. THIS IS IMPORTANT! The layers will not pop up if you are not signed in! If you do not already have an ArcGIS Online account, it is free to create one. 
2. Click on Make a Map 

[image: ]

3. On the Map screen, click on Modify Map. 

[image: ]
4. Next click on Add, then select Browse Living Atlas Layers.

5. Search for Sea Surface Temperatures (°C)

[image: ]

6. When you locate the layer, click the + sign. 

7. Next, search for chlorophyll.

[image: ]

8. When you locate the layer, click the + sign. 
9. Finally, search for NOAA buoy.[image: ]

10. When you locate the layer, click the + sign. 

11. Now we have added all the layers we need for our map. 

12. Click on Details, and then click on Content. You will now see the layers we have added to the map. It should look like this. Turn OFF the NOAA buoy Station data by unchecking the box next to it. [image: ]
13.  Now you can check your answers from Part A, to ensure you plotted your buoy stations correctly. Make sure your map view is centered on the east coast of the United States. 

14.  Hover your mouse under the buoy layer. You should see several symbols. Click on the image that looks like a table (it should say Show Table). Under your map, a list of all the attributes (data) associated with the buoy layer pops up. You should see two columns of data, one for latitude, and one for longitude. These are expressed as decimal degrees, just as you did in your Part A.[image: ]

15.  In the table, sort your station IDs in ascending order by clicking on the column header and selecting Sort Ascending.[image: ]

16.  Now scroll through your list to find your stations. As an example, we have shown you station ID 41001. Click on that row and it will highlight that station on the map. You can use this to check your work from Part A. [image: ]

17. Now we will explore a bit about the data. Under each layer, if you drag your mouse pointer under it, you will see several symbols. If you hover the mouse over the three dots, and you will see “More Options.” [image: ]

Click on the dots for the Sea Surface Temperature layer. A dropdown list appears. Scroll down to Show Item Details. This is the metadata. 

18. Where did they get this data? Click on source data to find out and list the satellites here.  

[image: ]____________________________________________________________________________________________________________________________________________________________. 

19. Follow steps 13 and 14 to look at the metadata for each of the layers. List the sources of the data here: __________________________________________________________________________________________________________________________________________________________________________________________________________________________________________.
20. Next, search for Monterey Bay, CA, USA in the Search box at the upper right of the screen. Zoom to this area. It might be easier to turn off your layers temporarily to see the bay. Be sure to zoom in to Monterey Bay the amount shown in the image below.  The outline and shape of Monterey Bay should be clearly visible.  [image: ]

21. Now we want to view the upwelling events. For this exercise, we are going to look at temperatures and chlorophyll to see when upwelling occurs. To do this, we need to manipulate the time series visible on our map. Note: time is automatically enabled for these layers. If for some reason you do NOT see a time slider on your map, go to the More Options for the layer, and select Enable Time Animation.

[image: ]

22. Let’s start with Sea Temperature. Under the Sea Temperature layer, hover your mouse under the layer, and then click on Show Table. This makes the attribute table visible.

23.  Notice in the table there is a column entitled “Standard Time.” Click on the column header and sort Ascending, then sort Descending. This will show you the range of time data available for the temperature layer.  What is year range for the data? ______________________________________________________________________________.

24. We want to focus on the year 2010. Notice there is a time scale at the bottom of the map. Click on the symbol that looks like a slider, then click Show Advanced Options. 

25. Now we will change the time range that the time animation will show. Set the Start time to 1/1/2010 and End time to 12/31/2010. Set the time display to Count 1, interval Week. Then click Ok. [image: ]

26. Turn off your chlorophyll layer so the temperature layer is more apparent. Click on the Legend Tab so that you can see the legend for the temperature layer. Notice on the slider there is a play button. Hit play. Watch the sea surface temperatures change throughout 2010. What two week period are the temperatures in the bay the coolest (should appear blue)?___________________________________________________________________________________________________________________________________________

27. Now we want to visualize an upwelling event. Return to your ArcGIS Online map. Click the Content tab again and turn off temperature and turn on the Chlorophyll layer. Click on Show Table to show the chlorophyll table. Once again we want to see the date range for the layer. Sort the Date layer ascending and descending. What is the year range for this layer? ______________________________________________________________________________.

28. Follow steps 20 and 21 to change the range on our time animation from January 1st, 2010 to June 30th, 2010. Keep our time display count as 1, and the interval as weekly, then hit OK.

29. Follow step 22 to view the changes in chlorophyll count in the winter/spring range for 2010. At what point are chlorophyll counts the highest (should appear dark red)? ____________________________________________________________________________________________________________________________________________________________.

30. Describe how wind direction influences primary production.(Upwelling is an important factor to consider as part of this answer.  ________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________.
[bookmark: _heading=h.30j0zll]
31. (Optional Question Depending on Class) Do some research on what organisms eat phytoplankton.  How will the increase in phytoplankton due to upwelling impact larger organisms?
______________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________
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Description of Measurements

Links which are specific to this station are listed below:

Real Time Data in tabular form for the last forty-five days.

Historical Data & Climatic Summaries for quality controlled data for the current month, previous months, and previous years.
‘The weekly status report and the weekly maintenance report also provide valuable station information.

Note that the payload types and the station locations occasionally change.
Please refer to the NDBC data inventory for the data history of each station.

US Dept of Commerce Policy
National Oceanic and Atmospheric Administration Information Quality Ereedom of Information
National Weather Service Glossary About Us

National Data Buoy Center Career Opportunities
Bldg 3205

‘Stennis Space Center, MS 39529
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